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 This Month’s Meetings 
Photo Editing Workshop 

Thursday, March 10 at 1:00 P.M. 
At FFG Library Bldg. 

 
Plateau Photography Club 

Thursday March 17 at 1:00 P.M. 
At FFG Library Bldg., 

 
General Meeting 

Monday, March 21 at 3:00 P.M. 
At 127 S. Senior Center 

Note Winter Hours 

PLATEAU PC USERS GROUP, INC 
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March Program Topic 
 

Windows 10 A Work in Progress 
     
 

Carl Nordeen will review Windows 10 cover-
ing these topics 
:  
 Pinning programs to the start menu,  
 Removing programs from the start menu, 
 Resizing tiles,  
 Grouping programs of the same type,  
 Microsoft Edge (replacement for Internet  
 Explorer) and other interesting features.  
 
 
 
 
 
 
 
 
 
 
Bring your questions and he will attempt to 
answer them! 
 

Special Note:  
Change in location and meeting times starting in April 2016 
 
Summer Hours start at 6:00 P.M. (April  though September) 
New location: Christ Evangelical Lutheran Church 

481 Snead Drive FFG 

mailto:www.PPCUGinc.com
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“FREE” Table 
We have set up a table at our member meetings to share our 
“extra” goodies with other club members. 
If you have something to give away, bring it in and put it on the 
FREE table.  It’s first come, first served.  If you see something 
you want, help yourself. 

 
Join the Club! 

Anyone interested to attend the general meeting or any of the SIG 
meetings as a guest will be charged $3.00 per person for any or all 
meetings in that month. Afterwards, you are encouraged to become 
a member of the Plateau PC Users Group.  
Our Club cannot exist without you, the members.  
  

Membership Dues  

Our annual dues are now payable July 1st of each year.  Annual 
dues are $24 per single person / $30 per family starting July 1, 
2014.with partial years dues as follows:  

 
 
Student memberships (21 and under) are $10 annually.  Corporate 
memberships are $30 a year for the first two memberships and $10 
 a year for each additional membership from the same compa-
ny.  Contact the PPCUG Treasurer (931) 707-3677 for pro-rated 
dues of these types of memberships. 
 

BOARD OF DIRECTORS DISCLAIMER 
 

All members of the Plateau PC Users Group are willing to help one an-
other in the area of advice and tutorial instruction over the phone.  If you 
should require more involved services or instruction, we have a few mem-
bers who are very knowledgeable in several areas.  As a responsible con-
sumer, it is up to you to discuss, before retaining a member, any and ALL 
charges for repair services and time consuming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees for individuals for 
services rendered, nor the responsibility to intervene between members 
who enter into a contract among themselves 
 
The GAZETTE is published using the following:  Microsoft Word, Mi-
crosoft Publisher, and Microsoft Windows.  The GAZETTE is the month-
ly newsletter of the Plateau PC Users Group.  Material in the GAZETTE 
may be freely used in other user group newsletters if credit is given the 
author and the PPCUG GAZETTE.   
 
DISCLAIMER:  No warranty, express or implied, is made by the 
PPCUG, the Gazette editorial staff or its contributing editors.  This ex-
tends to all losses incidental or consequential from the use or non-use of 
any information in any issue of the GAZETTE. 
 

 
 

 
 
 
 
 

 
 

2015- 2016 

    

Join Date Jan. 1, 
2016 

Apr. 1, 
2016 

July 1, 
2016  

Annual Dues 

Oct. 1, 
2016 

Single: $12 $6 $24 $18 

Families: 
$15 $7 $30 $22 

President Steve Rosenstein (931) 742-0151 

Vice-President/ 
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Secretary Richard Del Frate (931) 456-2251 

Past President Carl Nordeen  (931) 456-5597 

Librarian Barbara Duncan (931) 456-2251          

Programs Open  

Membership Dolores Crabtree (931) 484-9013 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 788-2201 

   

Directors at Large 

Alan Baker Gordon Botting Dolores Crabtree 

Barbara Duncan Bob Willis Linda Yates 

Director Emeritus 
Don Lewis  

    

 SIG Leaders   

Photo Editing 
Workshop 

Ed Thornblade (931) 456-6020 

Plateau Photography 
Club 

Jim Mansfield (931) 484-6920 
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Up Coming Meeting April 2016 

  
Note: Summer Hours & New Location 

 
The next General Meeting of the 
PLATEAU PC USERS GROUP 
Will be on April 18 at 6:00 P.M. 

at Christ Evangelical Lutheran Church 
481 Snead Drive FFG 

(corner of Snead & Lake View) 
 
 

Classes  
Please send ideas for new classes to Alan Baker 

( ambaker@citlink.net ) 
  

Cool Tips & Sites 
“hey Cortana!” 

 
As you’ll know by now, Cortana has arrived on 
the desktop. If you don’t feel entirely comfortable 
shouting out “hey Cortana!” across a crowded 
room, then there are keyboard shortcuts that can 
help— 
 
Windows Key+Q — open up Cortana ready for 
 voice input. 
 
Windows Key+S — open up Cortana ready for 
 typed input. 
 
Windows Key+I — open up the Windows 10  
 settings pane. 
 
Windows Key+A — open up Windows 10 notify
 cations (Action Center). 
 
Windows Key+X — open the Start button con
 text menu the one with 
 easy access to a host of 
 common computer manage
 ment features 
 
Once Cortana is active, you can choice voice or 
keyboard input. 

PPCUG ISP 
We wish to thank the following for providing  

ISP connections:  
 

Frontier for DSL at the : 
 127 Senior Center, Crossville, TN 

 PPCUG Website 
 

Visit our website at www.PPCUGinc.com. The Learn-
ing Center class schedule and Gazette are all 

 available on our web site. 
 

Send your comments and suggestions to the  
Webmaster, Don Lewis 

Webmaster@ppcuginc.com  (931) 456-5352 

News of the Special Interest Groups 
 
The PPCUG sponsors several Special Interest Groups 
(SIGs) tailored to meet the varied needs of our many 
members.  Each SIG is a small group whose leader 
prepares material for presentation and encourages 
open discussion and questions.  We urge you to attend 
the SIGs and hope you will find one or more of inter-
est to you.  Ideas for additional groups are welcome, 
as are volunteers to form and lead new SIGs. 
 

Plateau Photography Clubs 

 
A photo editing workshop is held at 1:00 PM at the 
Fairfield Glade Library Bldg. on the second Thurs-
day  of each month.  Members meet to discuss & 
demonstrate various editing software programs avail-
able to enhance their photographs. The SIG leader is 
Ed Thornblade. 
 
 
The Photography Club, a PPCUG SIG, meets the 
Third Thursday of each month at the Fairfield Glade 
Library Bldg. at 1:00PM.  Topics vary each month 
but we show and discuss member's photos each 
month.  The SIG leader is Jim Mansfield.  
 

The Photo Club/SIG website 
 
The Photo Club/SIG website is now up.  Access 
to it is through the PPCUG website, using the "Photo 
Club" navigation link at the top of each PPCUG 
page.  I think that this is a big improvement, and 
could not have been done without the work of  
Dallas Richards. 
 

 PPCUG Website 
 

Visit our website at www.PPCUGinc.com. The 
Learning Center class schedule and Gazette are 
all available on our web site. 
 
Send your comments and suggestions to the  
Webmaster, Alan Baker 
Webmaster@ppcuginc.com  (931) 788-2201 
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PPCUG General Meeting Minutes February 15, 2016 
 

AARP 2015 Tax Preparation, by Bob Willis 
 

A forecast of nasty weather apparently convinced most of our members that compounding discomfort with 
facing income filing information was too much to ask, so they stayed home. The small crowd did however 
come up with several questions during the Q and A portion of the meeting.  
 
Carl began the Q&A with a question of his own, asking how many of those present were already using  
Windows 10. Several admitted they had taken the plunge. He just wanted to reiterate that Windows 10 is still 
a work in progress. 
  
The subject of importing favorites in Windows10 came up. Answer is yes it can be done and help is available. 
Asking the question of “Cortana” or typing it in the search bar, (lower left task bar), will call up menu for 
several options depending on where you want to import from and where you want them to go to 
.  
One person asked about changing how CCleaner works. He was having a problem because it was deleting his 
history files in the Firefox browser. The answer is to open CCleaner then highlight to cleaner brush icon on 
left-hand menu column then put checks in the boxes of items to be “cleaned” or remove the checks from 
items you want left alone. Each browser has its’ own section. 
  
I had a question about an auto-shutdown of my computer after startup this morning caused by according to 
the warning on the screen, a cooling fan malfunction and overheat. My question was, how do I find out how 
hot it was? Carl’s answer was to check the temperature shown in the “health” tab while running Defraggler.  
I also have Speccy from Piriform on my machine and that also will show internal temperatures. Happily in 
my case the problem was alleviated with a blast of compressed air in the vents to blow the dust out of the fan 
and cooling passages. 
  
One individual was having a problem not being able to delete unwanted portions of email messages received 
from someone else before forwarding remainder to another party. It seemed that all the normal methods were 
not working for him such as highlighting the portion to be eliminated then either using the delete key or the 
backspace key to remove. A reminder was made to insure that it is critical to first make the email yours by 
keying the reply or forward before attempting to change the email. Until it is yours, you can’t edit. 
  
Someone wanted to be able to change the sizes of the partitions on his hardrive because he was getting mes-
sages saying he didn’t have enough space for certain operations. Carl recommended a free (leave it to Carl to 
find these things and that saves enough in a year to pay for the cost of dues), program called EaseUS Partition 
Master. It will allow reallocating space as needed. An integral part of Windows 7, 8.1 and 10 also contains a 
tool that can be used to change partitions with some limitations. That tool is disk management. A search  
query will give directions on how to access disk management in Win10 through computer management.  
 
After the break Jim Buxton, vice president of the club took a little poll of those present to see how many were 
from the “Glade”? The majority were. He then mentioned that the general meetings in April, May and June, 
will be held at the Christ Lutheran Church at Lakeview rd. and Snead in the Glade. This is being done as an 
experiment to see if moving our location to Fairfield will enhance our value to our members and encourage 
increased participation and membership. If this is successful obviously the Board will consider how best to 
proceed.  
 
Bob Willis one of our long time members, is also very much involved in the AARP Tax preparation program 
not only on a local level but also state and national administration. Bob’s presentation covered changes  

(Continued on page 5) 
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affecting tax law for tax year 2015 filings as they apply to typical Cumberland County residents. Yes, these 
changes apply to all but the focus for the AARP program does not cover complex filings or business filings. 
For high income, complex or business filings it is recommended to hire a CPA or professional tax prepara-
tion service.  
 
I will not attempt to cover the tax law changes discussed but I will mention that part of the presentation was 
Bob demonstrating use of online tax preparation programs such as are available through Walmart, Costco, 
Staples and others at reasonable cost for those who may want to do their own taxes.  
 
Bob also stated that he has received emails forwarded to him by some members of lists of tax changes and 
additions attributed to the “Affordable Health Care Act” notoriously referred to as Obama care. Bob wanted 
to clarify that he did research these statements and at least in most cases they are not accurate. Some of the 
tax statements have some truth but predate the AHCA. Others are not accurate in other respects and almost 
all would not apply to the typical taxpayer but might apply to a high income taxpayer. 
  
AARP Tax Preparation assistance is now being conducted nearly every day of the week one of these loca-
tions near you, such as Art Circle Public Library, Fairfield Glade Community Center, Community Center at 
Lake Tansi or the Community House at Pleasant Hill. 
   
Submitted by:  
 
Dick Del Frate 
Secretary 
 
 

FreeCast and RabbitTV 

 

Review by George Harding, Treasurer, Tucson Computer Society, AZ 

September 2015 issue, TCS eJournal 

www.aztcs.org 

georgehardingsbd (at) earthnlink.net 

 

I received a card at CES for free registration for FreeCast. I had some trouble figuring out what sort of ser-

vice it is. 

It appears to be a source for free TV, movies, radio, sports, games and more. 

The TV shows available are not just network regulars, but also cable shows. You can pick a particular show 

and see episodes of it for free. There are interspersed ads, of course, but that’s no different than real TV. You 

can search for your favorite show and watch episodes of it. 

I watched parts of U-571 and Harry Brown movies for free. Each came from Crackle through Rabbit TV, an 

associated company. There was, at the time I was browsing, a selection of many movies in several genres. 

The movies are uncut, but have interspersed commercials. 

(Continued from page 4) 
 

(Continued on page 6) 
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Some of the movies come from satellite services. To see these, you have to be a member of that service. 

 

One of the big advantages of FreeCast is the ease of finding what you want to watch. Most of the time you want 

to watch immediately, but for some you can also download the offering. 

 

This service used to require a USB unit which cost $10, but apparently there is enough income available from 

ads and commercials to fill the gap. 

This is an interesting service. While it doesn’t take the place of your TV set, it is convenient and very low cost. 

 

About:  FreeCast and RabbitTV  

Manufacturer: www.freecast.com and www.rtv2.rabbittvgo.com 

Price: Mostly free 

 

 
 
 
 
 

Enliven Documents with Themes 
 

 
By Nancy DeMarte, 1st Vice President, Sarasota Technology User Group, FL 
October 2015 issue, Sarasota Technology Monitor 
www.thestug.org  
ndemarte (at) Verizon.net 
 
If you often find yourself creating documents in Word or spreadsheets in Excel, you probably use the same font 
and layouts most of the time.  
 
You would be surprised how lively and stylish these files could be if you applied a theme to them. Themes in 
Word and Excel are Style sets that coordinate the color scheme, fonts, line and paragraph spacing, and effects.  
 
The Themes gallery is located on the Design tab in Word and the Page Layout tab in Excel. I will use Word 
2013 as an example of how you can apply and customize themes in your documents.  

(Continued from page 5) 

(Continued on page 7) 
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Choose and Apply a Theme 
 

 
 
The default theme in Word and other Office programs is appropriately named “Office,” but you can apply a  
different theme to a document either during its creation or after. For example, I opened a blank document, 
clicked the Design tab, then Themes (left side of the ribbon), to open the Themes gallery. I chose the “Ion” 
theme, although I could have browsed for more online. A group of Styles that coordinate with this theme  
appeared in the ribbon. I chose a colorful one called “Lines (Simple)” and began to create my document.   
 
First, I typed the title and highlighted it to display the Font toolbox just below it. I clicked Styles (bottom right) 
and selected the Title style, which changed my title to a maroon color and 40-point text. The title seemed too 
large, so I reduced the font size to 24 points. All these font changes can also be made on the Home tab – Font 
group. 
 
Next, I typed an introduction and my first heading, highlighted it, chose Styles from the font toolbox again, and 
picked Heading 1. It also was a maroon color, 18 points, and included a line below it. I changed the size to 14 
points to be consistent with the new title size. 
 
Then I typed the body of the document. After I had typed the first line of text, I clicked inside a word and 
learned that the theme’s body text was Century Gothic, 10.5 point, Normal style.  
Just for fun, I added a couple of shapes from the Shapes gallery (Insert tab – Shapes) Sure enough; they too 
were a maroon color, keeping with the theme.  
 
Customize and Save a Theme 
 

 
 

(Continued from page 6) 

(Continued on page 8) 



Gazette  March 2016     www.PPCUGinc.com                                                    Page 8 

Next, it was time to experiment with changing a few of the elements of the theme. With my document open, I 
clicked the Design tab and then Colors, which revealed a menu of color schemes, each which included several 
coordinated colors. I clicked “Blue” and immediately found that all my maroon-colored features had turned a 
medium blue. Then I clicked Fonts and chose “Times New Roman – Arial.” The title and all the headings be-
came the Times New Roman font, while the body text changed to Arial.  
 

 
 
With my cursor still in the document, I clicked Paragraph Spacing, which displayed a list of preset distances 
between lines and paragraphs. Hovering my mouse over Default showed my theme’s spacing. I hovered my 
mouse over each of the choices to preview how it would affect my document. I decided on the Open spacing 
set, which added a little more space between lines and paragraphs. Because I had only a few objects or shapes 
in this document, I did not change the Effects, but clicking that icon showed me what changes were possible.  
Now it was time to save this custom theme. I clicked the Design tab, Themes button, and selected “Save Cur-
rent Theme” at the bottom of the gallery. I typed a name, “My Ion,” in the dialog box and clicked Save. This 
put my modified theme into the Custom area above the Theme gallery. The theme was also stored as 
MyIon.thmx in a special Document Themes folder.  
 
Two Important Cautions 
 

 
 
1. Don’t confuse saving a theme with setting it as the default.  If you save your custom themes, you have the 

choice of when to use them. If you set a custom theme as the default, it will affect all future documents and 
may give you some unexpected results. 
 

2. The Office theme is different from the rest in the theme gallery in that it affects all of the Office  
 applications. If you make a change to the Office theme, such as changing the background from white to 
 gray, and set it as the default, it will affect all programs in your Microsoft account, including those on other 
 computers. However, saving your own custom themes in Word or Excel can be a handy way to give your 
 documents some style and avoid re-creating a favorite theme each time you need it. 
 

(Continued from page 7) 
 



Gazette  March 2016     www.PPCUGinc.com                                                    Page 9 

How to Set Up and Customize Email Accounts in Windows 10 

 

Windows 10 comes with a built-in Mail app, from which you can access all your different email accounts 

(including Outlook.com, Gmail, Yahoo!, and others) in one single, centralized interface. With it,  there’s no need 

to go to different websites or apps for your email. Here’s how to set it up. 

Setting up Mail From Other Accounts 

Mail supports all the most popular mail services, including Outlook, Exchange, Gmail, Yahoo! Mail, iCloud, 

and any account that supports POP or IMAP. Click the Mail tile to start the app, and press the “Get Started” 

button. If you’re logged into your Microsoft account, the app should already have your outlook.com email ad-

dress in the list. Click the “Settings” icon in the lower left-hand corner, or swipe in from the right edge of the 

screen, and then tap “Settings.” From the right sidebar go to Accounts > Add Account.  

 

The “Choose an account” window will appear. Mail comes ready with all kinds of popular email services. 

Choose the type of account you want to add and follow the on-screen instructions. If your settings are correct, 

then you’ll jump directly to that account’s inbox, ready to start processing mail. If you’ve set up more than one 

(Continued on page 10) 
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account, you can switch among them by selecting “Accounts” in the top left corner.

 

Link Multiple Inboxes Together 

In Mail, you can link your inboxes together, so you can see all the messages from all your accounts in one uni-

fied inbox. Point your mouse to the lower-right of the screen and click “Settings.” From the right sidebar, click 

“Manage Accounts > Link inboxes.” 

 

A pop-up box will open. Now, simply choose the accounts you want to link and give the new linked inbox a 

name. 

 

(Continued from page 9) 

(Continued on page 11) 
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Customize Your Mail Experience 

Click the Settings button in the lower right-hand corner of the screen, or if you’re on a touch device, swipe in 

from the right edge and then tap “Settings.” There are two kinds of settings in Mail: those specific to an ac-

count, and those that apply to all accounts. Settings that apply to all accounts let you tweak the entire aspect of 

your Mail experience, including personalization and reading options. 

Go to Settings > Personalization in the right sidebar. Here, you can pick from a collection of 10 different hues 

or use the Windows accent color for seamless integration. You can toggle between the light and dark theme and 

set the background to cover the entire window or just the right pane where you read new messages and com-

pose new mails. To add your own background picture, click “Browse” and select any picture stored in your PC. 

 

For more functional customization, click on Settings > Reading in the right sidebar to manage your day-to-day 

mail reading experience. For example, Caret Browsing in Mail lets you navigate the reading pane with your 

keyboard cursor. You can use the arrow keys, Page Up/Down to scroll, and press Home or End to jump to the 

beginning or the end of a message. 

You can toggle “Auto-open next item” on or off to indicate what you want to do when you delete a message—

move to the next message, or go back to your background picture. Mail also lets you decide when a message is 

marked as read: 

· When selection changes (that is, when you choose another message) 

· Don’t automatically mark item as read (you have to mark it as read manually) 

(Continued from page 10) 

(Continued on page 12) 
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· When viewed in the reading pane (it makes Mail flag a message as read only after you’ve had it open for 

a certain number of seconds) 

 

If you have more than one account in Mail, then you can tweak certain settings on a per-account basis. In the 

settings menu, these can be tweaked for each individual account: 

· Quick Actions: Also known as Swipe Actions, this lets you operate on a message in the list by dragging 

your finger left or right across it. Swiping right marks the message as flagged and to the left archives it. 

However, you can customize what that right swipe and left swipe will do (or turn off swipe action feature 

entirely). You can set or clear a flag, mark a message as read or unread, archive, delete, or move. 

· Signature: This lets you create and add an email signature to all the messages you send from a particular 

account. 

· Conversation: Grouping messages by conversation is turned on by default, and groups all messages that 

have the same subject into one thread. 

· Automatic Replies: Available on Outlook and Exchange accounts only, you can turn this on to send auto-

matic replies to people when you know you’re not going to see your emails for a while. 

 Notifications: Windows will let you know when a new message arrives for a particular account. Turn on 

“Show in action center,” and then specify how you want to be notified–with a sound or a banner. You can 

customize notifications for each email account separately as per your needs. 

· Automatically download external images and style formats (available in the Reading section): Decide 

whether you want Mail to automatically download images. If you turn this off, you can choose to down-

load external images in messages as you read them. 

(Continued from page 11) 

(Continued on page 13) 
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(Continued from page 12) 

 

You can also pin one account’s inbox or any other mail folder to your Start menu for instant access and efficien-

cy. For example, if you have a folder called Important, you might want them pinned on your Start menu. Right-

click the folder you to pin, and choose “Pin to Start.” Click that pinned folder and you’ll be taken straight to that 

folder. 

Customize How Your Accounts Download Messages 

Lastly, you can go into each account’s individual settings to tweak how it downloads new messages. Go to Set-

tings > Manage Accounts and click on an account to edit it. You can change its name or delete the account, but 

most important here is the “Change mailbox sync settings” section, which includes: 

· Download new content: This menu lets you choose how frequently the Mail app will check for new mes-

sages. Usually “As items arrive” is what you want. Some account types offer only “Every 15 minutes,” 

“Every 30 minutes,” and so on, if you’d rather not be inundated with notifications. If you choose “Manual,” 

then Mail never checks unless you hit the “Sync” button. Mail can even dynamically manage how often 

new mail is downloaded based on your usage. 

 

            (continued  on page 14) 
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· Always download full message and Internet images: Instead of fetching an entire message, clear the 

“Always download full message and Internet Images” checkbox. This will let you view small previews of 

your incoming messages, so that you can navigate your inbox more efficiently. If you have a slow internet 

connection or want to reduce your data usage, then this option might be useful to you. 

· Download email from: How far back do you want your mail collection collected? If you have a phone or 

tablet, then you might want to limit the number of messages stored in the Mail app. “The last month” option 

is a good choice and enough for day-to-day usage. 

 

· Sync Options: Here you’ll see three items: Email, Calendar, and/or Contacts. Toggle the items you wish to 

sync with your account on or off. If you’re facing any sync related issues, click on “Advanced mailbox set-

tings” to configure the Incoming email server, Outgoing email server, Calendar server, and Contacts server. 

 
 

(Continued from page 13) 
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Plateau PC Users Group, Inc. 
Application for Membership 

 
_______ New Member      ______ Renewing Member 
 
Return this application, with check for annual dues payable to “PLATEAU PC USERS GROUP.”  Return to the 
club Treasurer during our meeting or mail to PPCUG Treasurer, P.O. Box 3787, Crossville, TN 38557.   
Our annual dues are now payable no later than July 1 of each year.  Annual dues are $24.00 per single  
person / $30.00 per family starting July 1, 2014. with partial dues as follows.  
   

 
 

____________ 
Date 
 
——————————————————————————————————————-- 
Last Name   First Name   Family Members (if family 
        Membership) 
 
——————————————————————————————————————- 
Address: 
 
 

City    State  Zip Code  Phone Number 
 
———————————————————— 
E-Mail address 

 
I have used PCs since (year): _____     I have belonged to a Computer Club before. Yes __ No ___ 
 
I have knowledge in the following areas that I would be willing to share with club members: 
 
 

 

 

 
I would like more information about the following areas: 
 

 

 

 
11/10/15 

 Join Date Jan. 1, 2016 Apr. 1, 2016 July 1, 2016 
Annual Dues 

Oct. 1, 2016 

Single: $12 $6 $24 $18 

Families: $15 $7 $30 $22 
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Note:  Please see page #15 for the Plateau PC Users Group, Inc. Application for Membership form.  

April 2016 

Sun Mon Tue Wed Thu Fri Sat 

     1 2 

3 4 5 6 7 8 9 

10 11 12 13 14 1:00 P.M. 

Photo Editing 
Workshop Mtg. 

15 16 

17 18 6:00 P.M. 

Q & A Session 
Followed by  
General Mtg. 
Note new Time 
& Location  

19 20 21 1:00 P.M. 

Plateau Photog-
raphy Club Mtg. 

22 23 

24 25 26 27 28 29 30 


